
Challenge: Insect Image



Challenge: Insect Image © Ben Willmore, All rights reserved 2

Challenge: Insect Image 

In this lesson, we are going to 
work on a challenge image that 
was submitted by a Masters 
Academy member. The image 
features a close-up shot of an 
insect and the challenge lies in 
removing an object from behind 
that insect’s partially-transpar-
ent wing. During the course of 
the lesson, we will learn how 
to combine retouching tools 
to get the best results. We will 
also learn how to tackle objects 
with partial transparency. 

Remove Dust Specks (Timestamp 1:00)

The first thing we’re going 
to tackle is the dust in the 
background of the image. 
This could be the result of 
dirt in the air or from a dirty 
camera sensor. We can get 
a better idea of how much 
dirt there is by opening the 
image in the Camera Raw 
filter (Filter menu > Camera 
Raw Filter) and then mov-
ing the Clarity and Dehaze 
sliders far to the right. 

In this challenge 
image, we are 
going to remove 
the object that 
appears behind 
the insect.

To get a better idea of how many spots there were, we 
opened the image in the Camera Raw filter and increased 
the Clarity and Dehaze settings.
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We will remove the dust in Photoshop’s main interface (not in Camera Raw). We 
COULD use something like the Spot Healing Brush to click on every dust speck, but 
that would take a long time. In this image, we are lucky because most of the dust is 
contained in an area that does not contain any detail. This allows us to use a more 
generic solution. We are also lucky in that the background is mostly one color, and 
that color is not contained in other areas of the image. This allows us to isolate that 
area rather easily. 

The Median Filter We’re going to use the Median Filter to remove the dust spots. 
Before doing so, we will duplicate the image layer by using the keyboard shortcut 
Command+J (Crtl+J on Win). We’ll make sure this duplicate is the active layer be-
cause this is the layer to which we want to apply the filter.

The Median Filter can be accessed by clicking on the Filter menu and choosing 
Noise > Median. The Median dialog will appear, displaying a preview window and a 
Radius slider. In this filter, we can click on a dust spot (in the main image window) 
and the preview window will zoom in to that location. Then, we can drag the Radius 
slider to the right, just until the speck disappears. We’ll click OK to exit the Median 
dialog.

LEFT: In the Median Filter, we clicked on a spot and the preview window zoomed to that  
location. RIGHT: The Radius slider is being increased until the spots are no longer visible.
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Now the dust specks have been removed from the background but the rest of the 
image (the flowers and insect) does not look good. That’s why we wanted to apply 
the filter to a duplicate layer. We’ll use a layer mask to isolate the effect so that it 
can not affect the subjects. 

Select Color Range We’ll temporarily hide the visibility of the top layer (where the 
filter was applied) and we’ll activate the bottom, original image layer. We’ll use this 
layer to create a selection of the background. There are many different methods for 
creating this selection, but we used the Color Range command in the video exam-
ple. We’ll click on the Select menu and choose Color Range. 

The Color Range dialog box will appear and we’ll start by moving the Fuzziness 
slider all the way to the left (to its lowest setting). The Eyedropper Tool will be 
active by default and we’ll use it to click within the image on the color we want to 
select. In this case, that’s the color of the background. 

Using the Select Color Range command, the Eyedropper is being used to click on the color 
we want selected.
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In the Color Range dialog, the preview screen shows a mini version of the image. 
The white areas depict what is selected and the black areas indicate what is not 
selected. After we initially click within the image, only a small area will become se-
lected. We need to use the add eyedropper ( + ) to add to this selection. We can 
either activate it by clicking its icon in the Color Range dialog or we can hold down 
the Shift key, which will temporarily turn the regular eyedropper into the add eye-
dropper ( + ). We’ll do this while clicking on additional areas of the background. 
This will select a wider range of colors and you will see that more of the preview 
window becomes white. 

The add eyedropper is being used to click in additional areas, expanding the range of colors 
that is selected. In the small preview window, the white areas represent the areas that are 
selected.
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If you would like to get a larger preview of the selection, you can change the Selec-
tion Preview menu (at the bottom of the Color Range dialog) to Black Matte. This 
will place a black overlay directly on the image in areas that are not selected. 

After making this initial selection, we can use the Fuzziness slider to fine-tune the 
results. The Fuzziness setting determines how much the selection can deviate from 
the colors we clicked on. As we move the slider up, it will select a wider range of 
colors. We’ll move this slider up until most of the background is selected and then 
we’ll click OK to exit the Color Range dialog. We’ll be left with a “marching ants” 
selection around the background. 

The Selection Preview menu (circled) is set to Black Matte. This places a black overlay  
directly on the image in areas that are not selected.

The Fuzziness slider is moved to the right, expanding the range of colors being selected.
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Add layer mask to limit effects of Median Filter Now we have an active selection of 
the background and this is the area where we’d like the Median Filter to be applied. 
We’ll turn on the visibility of the top layer and we’ll click on it to make it active. This 
is the layer on which the Median Filter was applied to remove the dust specks. 

We’ll add a layer mask to this layer by clicking on 
the Layer Mask icon at the bottom of the Layers 
Panel. Because there is an active selection at the 
time the mask is added, the selection will automat-
ically be applied to the layer mask. The selected 
areas will be the white part of the layer mask and 
therefore the only part of the layer that is visible. 

After exiting the Color Range command, a “marching ants” selection is created around the 
background.

A layer mask was added to the 
layer that contains the effects of 
the Median Filter.
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Refine the layer mask After making a selection and 
layer mask using this method, you may need to fur-
ther refine the mask. That’s the case in the video ex-
ample. You can see that there is some undesirable 
artifact in the small crevices of the image. These 
came from the Median Filter.

We can view the mask in the main image window 
by holding down the Option key (Alt on Win) and 
clicking on the mask icon in the Layers Panel. The 
black areas represent the areas where the Median 
Filter will NOT be applied, so we want to expand 
the black into those little areas with the undesirable 
artifact. We can do that using a filter.

The Minimum and Maximum filters Because we’re viewing the mask in the main 
image window, we can apply a filter directly to it. We’re going use a filter to min-
imize the amount of white in the mask. We’ll click on the Filter menu and choose 
Other > Minimum. 

Note: Both the Minimum and Maximum filters think about the amount of white in 
the image. The Minimum filter reduces the amount of white and the Maximum filter 
will maximize the amount of white in the image. 

The Minimum dialog will appear 
and it presents us with a Radius 
slider. The higher we move this 
slider, the more the black areas 
will expand (and the white ar-
eas will therefore contract). We’ll 
move this Radius slider up by 
about three or four, just enough 
so that the black expands away 
from the edges of the objects in 
the image. We’ll click OK to exit 
the Minimum filter dialog. 

Some artifact from the Median 
filter layer remains, which means 
we need to refine the layer mask.

We’re viewing the layer mask in the main image  
window and the Minimum filter is being applied  
directly to the mask.
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Levels adjustment to fine-tune mask After using the Minimum filter to lessen the 
white areas in the mask, we are left with some dark specks in the background, 
which should be completely white. We can correct this with a Levels adjustment. 
Remember, we are still working on the layer mask, which is visible in the main im-
age window. We’ll click on the Image menu and choose Adjustments > Levels. The 
Levels dialog will appear and there will be three sliders beneath the Levels chart. 
The black slider (on the left) controls the black point, forcing more and more areas 
to black. The white slider (on the right) controls the white point. We’ll move this 
slider to the left, forcing more areas to white, until all of the dark specks disappear 
from the background area. We’ll click OK to exit the Levels dialog. 

LEFT: After using the Minimum filter to 
reduce the whites and increase the blacks, 
there are some dark specks in the  
background.

BELOW: A Levels adjustment is being used 
to remove the dark specks. In the Levels 
dialog, the white slider is being moved to 
the left, forcing more areas to white.
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Adjust the mask with the Brush Tool You can also use 
the Brush Tool to modify the mask. Paint with black in 
areas where you don’t want the layer to be visible and 
paint with white in areas where you do want the layer 
to be visible. 

In the video example, we have one dark spot left in 
the background area. We’ll activate the Brush Tool 
and paint with white to remove the spot. 

The mask looks better now, so we can stop viewing 
it in the main image window. We’ll again hold down 
the Option key (Alt on Win) and click on the mask 
thumbnail in the Layers Panel. The main image will be 
visible again (instead of the mask) and we can inspect 
the results.

In the video example, we still had some 
artifact between the fine details in the 
image, so we corrected this by using a 
small brush to paint with black on the 
mask in the areas where we saw the ar-
tifact. 

Note: You do not need to be viewing the 
mask in the main image window in or-
der to paint on the mask. As long as the 
mask is active, you can be viewing the 
image while painting on the mask. 

The Brush Tool is being used 
to paint with white over the 
spot in the background. We’re 
painting on the layer mask.

We’re back to viewing the image in the 
main window (instead of the mask) but we 
are still adjusting the mask with the Brush 
Tool. The active layer contains artifact be-
tween the flower details and we’re painting 
on the mask with black to hide that artifact. 
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Spot Healing Brush to remove any remaining spots The Median filter was success-
fully used to remove the vast majority of the dust spots. If there are any remaining 
spots, you can tackle them with the Spot Healing Brush. That’s what we did in the 
video example because we had one or two remaining spots. 

When working with the retouching tools, it’s always a good idea to work on a 
separate layer, so we created a new, empty layer at the top of the layer stack. We 
activated the Spot Healing Brush and made sure that the Sample setting in the Op-
tions Bar (above the image window) was set to “Sample All Layers.” This allows us 
to apply retouching on an empty layer. We then used the Spot Healing Brush, set 
to a hard-edged brush, to click on the leftover dust specks. 

Using Clone Stamp Tool to Retouch Top of Object (12:58) 

Now it’s time to retouch the object behind the 
insect. We already created an empty layer on 
which to place the retouch work, so we’ll make 
sure that top layer is active. Looking closely at 
the object behind the insect, we can see that it 
will need to be removed in stages. 

We’ll start with the red part that is extending 
out from the top of the insect. This is the most 
straight-forward retouching job. We’ll activate 
the Clone Stamp Tool for this task. Zooming in 
on the area, we can see that the edge of the 
insect is slightly soft. We’ll want the softness 
of the Clone Stamp brush to match this level 
of softness. With the Clone Stamp Tool active, 
we can adjust the brush settings within the 
Options Bar above the image window. We’ll set 
the brush hardness to about 60%. 

We’re going to remove the object in 
stages, starting with this top part.

The brush settings can be found in 
the Options Bar.
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We’ll also make sure that the Sample menu 
is set to “Current & Below.” This will allow the 
tool to work on an empty layer. 

To use the Clone Stamp Tool, hold down the 
Option key (Alt on Win) and click on the area 
that you want to sample from. In the video 
example, we sampled from an area of sky 
that is right above the object we’re going to 
remove. Then, when you release the mouse button, you can click in the area you 
want to retouch. This will paint the sampled content directly into this area. A 
preview of what will be pasted appears within the circular brush tip. In our exam-
ple, we clicked to paint over the red object, taking care not to extend the paint 
strokes into the edge of the insect. 

When retouching on an empty layer, 
make sure that the tool’s Sample 
setting is set to “Current & Below.”

ABOVE: The Clone Stamp Tool is being used to 
sample from an area in the background.

ABOVE RIGHT: The Clone Stamp Tool is being 
used to paste the sampled content over the un-
wanted object. 

RIGHT: The top of the object was successfully 
removed.
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Use Clone Stamp Tool Along with the Healing Brush (15:10)

Next, we’re going to remove the part of the 
object that is visible between the insect’s 
head and the flower petal. The Clone Stamp 
Tool can be used for this as well. To retouch 
the area where the flower petal meets the 
background, we will sample from anoth-
er [clean] area where the petal and back-
ground meet at a similar angle. Again, we’ll 
hold down the Option key (Alt on Win) and 
click to sample that area. Then, we’ll release 
the Option key and paint over the retouch 
area, removing the object. Again, we will try 
to match the softness of the Clone Stamp 
brush to the softness of the edges in the im-
age. 

Both the Clone Stamp Tool and the 
Healing Brush will be used to remove 
this part of the object. 

LEFT: The Clone Stamp Tool is being used to sample an area where the petal meets the clean 
background. CENTER: The Clone Stamp Tool is being used to align the sampled content with 
the edge of the petal in the retouch area. RIGHT: We are painting in the sampled content with 
the Clone Stamp Tool to remove the unwanted object. 
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The insect has some fuzz under his head, and that’s 
going to get cloned away as we paint in the sam-
pled area. We’ll need to find a way to replace the 
fuzz, so we’ll look for other areas of the insect that 
have fuzz to sample from. There is some fuzz on 
top of the head which comes in contact with the 
blue/gray background, so we can use that. It will be 
oriented in the wrong direction, but that’s OK. We 
can change the Clone Source settings to change 
the orientation of the content we copied. 

To copy the fuzz from one area to another, we will 
actually use the Healing Brush Tool, which will at-
tempt to match the brightness and color of the re-
touch area to the surrounding area. We’ll use the 
Healing Brush to sample from the fuzz on the top of the head. Then, we’ll open 
the Clone Source Panel. If it is not already viewable on your screen, you can ac-
cess it by clicking on the Window menu and choosing “Clone Source.” 

The Clone Source Panel The Clone Source panel contains settings that allow you 
to change the size, rotation and orientation of the copied content. We’re going 
to need to use a lot of these settings in order to manipulate the sampled fuzz so 
that it is facing the correct direction.

We copied fuzz that is pointed upward and we need it to point downward, so 
we’ll click the Flip Vertical button (see screen shot). 

We’re going to copy the fuzz 
from the top of the head and 
use it to replace the fuzz on the 
bottom of the head. 

After sampling fuzz from the 
top of the head, we used the 
Flip Vertical setting in the 
Clone Source Panel to flip  
the fuzz upside down so that 
it can be copied to the  
bottom of the head.
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The fuzz should also be pointed the other direction, so we can also click the Flip 
Horizontal button. When we look at the preview (of what will be pasted) inside 
the Clone Stamp brush tip, we can see that the angle is still a little off. It needs 
to be rotated counter-clockwise slightly. We can use the angle setting within the 
Clone Source Panel to achieve this. To change the angle setting, you can either 
manually type in a number (a negative number would rotate counter-clockwise) 
or you can click and drag left or right on the angle icon. This will automatically 
change the setting. 

Clone Source Shortcuts The Clone Source settings can also be adjusted using 
keyboard shortcuts. Let’s look at a few:

Shift+Option+Arrow keys: Reposition content

Shift+Option+ > : Rotate content clockwise

Shift+Option+ < : Rotate content counter-clockwise

Shift+Option+ ] : Scale content up (to make it larger)

Shift+Option+ [ : Scale content down (to make it smaller)

NOTE: On Windows, use the Alt key instead of the Option key.

Before painting with the Healing Brush, we 
need to look at some settings in the Options 
Bar above the image window. We need to 
make sure that the “Aligned” check box is 
turned on and that the Sample menu is set 
to “Current & Below.” Now, we can start to 
paint in the fuzz that we sampled with the 
Healing Brush, making sure that we don’t 
bump up against the head or body of the 
insect. Because it’s a healing tool, it will at-
tempt to match the color of the surround-
ing area (the blue/gray background). 

The Healing 
Brush Tool is  
being used to 
paint the copied 
fuzz (from the 
top of the head) 
onto the bottom 
of the head. 
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Remove Object from Behind the Transparent Wing (23:22)

Now we’re going to focus on the area where the unwanted object intersects with 
the insect’s body and lower wing. Part of the wing is transparent and you can see 
the object through that area. The body is also covered with fuzz.

We will use the Clone Stamp Tool, which creates a blatant copy and does not 
attempt to match the color of the surrounding area. We’ll sample from an area 
of clean background and then start to paint over the object, taking care that we 
don’t paint over the body or the solid part of the wing. It’s ok that we’re painting 
over the fuzz and the transparent part of the wing. We will clone those back in 
separately. 

We need to find areas that we can sample from to 
bring back the fuzz that we removed from the in-
sect’s body. The fuzz we removed was touching the 
upper joint in the body. If you look at the image, you 
will see that there is a second body joint that con-
tains fuzz as well. This area is not obstructed and 
we can therefore copy from this area to paste over 
our retouch area. 

LEFT: We’re going to remove this part of the object using a combination of tools. RIGHT: The 
Clone Stamp Tool is being used to copy from a clean area of background and then paste it 
over the object. The fuzz and part of the wing are being erased as well, but we’ll bring those 
back later.

We’re going to copy the fuzz 
from the clean area and paste  
it over the obstructed area.
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We’ll use the Healing Brush because it will try to match the color of the surround-
ings. With the Healing Brush active, we’ll sample from the clean fuzz on the lower 
body joint. Then, we’ll open the Clone Source Panel and make sure that it is using 
default settings. You can return the panel to its default settings by clicking the 
little u-turn icon         on the right side of the panel. 

We’ll position the cursor over the retouch area and will make the brush larger so 
that we can get a better preview of the content we’ll be pasting. This allows us to 
better line up the sampled area to the clone area. With this large brush, we can 
click to apply the tool and then immediately use the undo command. This sounds 
counterintuitive but it’s actually locking in the position of the content we’re past-
ing. We can now make the brush smaller and carefully paint over just the fuzz. 

We also need to replace the fuzz that used to extend upward toward the insect’s 
wing. The original fuzz got shorter and shorter as it moved upward. We can copy 
the fuzz that extends down to the bottom of the body and then flip it vertically 
using the Clone Source settings. We will also need to adjust the angle of the sam-
pled content so that it aligns with the insect’s body. Again, we’ll use the Clone 
Source settings to do this. 

LEFT: The Healing Brush is being used to sample an area of fuzz. CENTER: The Healing Brush 
is positioned over the retouch area and we made the brush large so that we could better see 
the preview and align the content. RIGHT: The Healing Brush is being used to paint the  
copied fuzz into the retouch area.
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When we go to paint in the sampled fuzz, we need to be really careful. Because 
we’re using the Healing Brush, it’s going to match the color of the area that’s 
immediately outside of the area where we painted. Because of this, we need to 
make sure that the paint strokes do not extend into the insect’s body because the 
tool will try to match the retouch area to that. 

The Fade Command If an effect is ever too intense, you can lessen it with the 
Fade command. This command allows you to lessen the effect of the very last 
thing you did in Photoshop. Note that it can not go back more than one step. 
When we were copying fuzz from one area of the insect to another, the fuzz we 
pasted appeared too bright. 

The Healing 
Brush was used 
to sample the 
white fuzz on 
the bottom. In 
the Clone Source 
Panel, we flipped 
the sampled 
content vertically 
so that it would 
align correctly 
when pasting it 
on the top part of 
the insect.

After retouching in 
the white fuzz, we 
could see that it was 
too bright. Here, we 
are using the Fade 
command to lessen 
the effect of the  
Healing Brush stroke. 
The Fade command 
can be used on the 
very last step you 
took in Photoshop.



Challenge: Insect Image © Ben Willmore, All rights reserved 19

Setting up an area for the Healing Brush

This is a technique that was used in a few different areas of the image. It was 
useful for tricky areas like the transparent parts of the wing. The Healing Brush is 
great for matching a retouch area to its surroundings and creating a smooth tran-
sition. You just need to make sure that the unwanted object is not part of those 
surroundings because you don’t want the Healing Brush to attempt to match 
that. 

When trying to retouch a tricky area, start by removing the unwanted object with 
the Clone Stamp Tool. The Clone Stamp Tool creates a blatant copy from one 
area to another. It does not attempt to create a smooth transition or match the 
colors to the surroundings. Just fill the area with the color that should ultimately 
be there. Don’t worry about the transition at this point. 

Then, activate the Healing Brush and use it to carefully clone the area where the 
transition should occur. Make sure that the brush does not hit any areas that con-
tain a color that shouldn’t be in the retouch area. The Healing Brush will fill the 
area with the detail that you sampled, but it will use the colors that are in the sur-
rounding area. That’s why it was important to start by inserting the appropriate 
color using the Clone Stamp Tool. 

In the video example, we could see the unwanted red object through the wing. 
We used the Clone Stamp Tool to remove the object, filling the area with content 
that was copied from another part of the wing. The result didn’t look refined, but 
the object was removed and the area was filled with the color that should ulti-
mately go there. 

ABOVE: We’re going to remove the 
object from behind the lower wing. 
RIGHT: The Clone Stamp Tool is 
being used to insert the appropriate 
color and remove the red object.
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Then, we used the Healing Brush to sample from a clean edge of the wing. When 
we used the Healing Brush to paint in the wing edge on the retouch area, it cor-
rectly inserted the detail from the wing edge, but it used the colors of the sur-
roundings so that the result looked natural. 

After filling in the 
wing with the  
appropriate color, 
the Healing Brush is 
being used to copy 
the edge of another 
wing and retouch 
the wing that was 
obstructed. The 
Healing Brush is 
matching the colors 
to the surrounding 
areas, making the 
result look natural. 


